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Introduction 
OtsTurntables is a revolutionary software turntable player. OtsTurntables unique real-time turntables, 
coupled with the emulated turntable effects, will give you the closest feel yet, on a software level, to 
turntable DJing. You can now scratch and mix your MP3s, WAVs, Ots files, CDs like a Pro DJ. 
 
This Quick Start Manual is dedicated to helping you get OtsTurntables up and running in a fast and 
efficient manner. For any further details on the features and functions of OtsTurntables please see the 
on-line OtsTurntables help documentation at http://www.OtsTurntables.com/doc/ , or the help file on 
your hard drive, go to Start -> All Programs -> Ots Labs -> OtsTurntables -> OtsTurntables help.

http://www.OtsTurntables.com/doc/
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Setup 
This section outlines the system requirements for OtsTurntables and how to install OtsTurntables. 
 
 
Minimum system requirements 
OtsTurntables has been programmed lean and mean. The OtsTurntables installation requires minimal 
disk space, approximately 2MB, and will run efficiently on the following minimum specifications: 

• OS: Microsoft Windows 2000, XP or Vista. 
• CPU: Pentium II 233MHz or better (Pentium III 500MHz or higher recommended). 
• RAM: 64MB or more. 
• Soundcard: A soundcard with DirectSound or WDM drivers. 
• Video: A video card capable of at least 16-bit "hi-color" mode with a screen resolution of 800 

x 600 or higher is required.  
• CD-ROM: To use the CD Digital Audio Direct capabilities, you will need a CD-ROM drive 

which can accurately read CD-DA streams (most name brands manufactured in the last few 
years are fine). A CD-ROM that uses constant angular velocity (CAV) technology is 
recommended. Click here for more details on the Ots Labs CD-DA subsystem requirements. 

 
 
How to install OtsTurntables Free 

• Double-click on the OtsTurntablesFreeSetup.exe installation file.  
• In the OtsSetup - OtsTurntables Free window click on Next --->. 
• Read the OTS CORPORATION SOFTWARE LICENSE AGREEMENT, and if you agree to 

the terms click on I Accept --->. 
• Click on the Begin Installing Files ---> button. 
• You will be prompted by the Installation Successful window, click on Next --->. 
• Your system may need to be restarted. Make sure that the Restart option is selected and click 

on Finish. 
• Please read the Important Audio Information window and click on the OK button. 
• You will be prompted by the Select "On-Air" output device dialog box. Select your main 

soundcard driver and click on the OK button. For more details on configuring OtsTurntables 
with your soundcard see below.  

• Enjoy the OtsTurntables Free experience! 
 
 
How to install OtsTurntables Bedroom/Silver/Pro 

• Double-click on the OtsTurntablesSetup.exe installation file.  
• In the OtsSetup - OtsTurntables window click on Next --->. 
• Read the OTS CORPORATION SOFTWARE LICENSE AGREEMENT, and if you agree to 

the terms click on I Accept --->. 
• Click on the Begin Installing Files ---> button. 
• You will be prompted by the Installation Successful window, click on Next --->. 
• Your system may need to be restarted. Make sure that the Restart option is selected and click 

on Finish. 
• Please read the Important Audio Information window and click on the OK button. 
• You will be prompted by the Select "On-Air" output device dialog box. Select your main 

soundcard driver and click on the OK button. For more details on configuring OtsTurntables 
with your soundcard see below.  

• You will now need to license OtsTurntables. For licensing instructions see below. 
• Enjoy OtsTurntables!
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Licensing OtsTurntables 
OtsTurntables uses the OtsReg licensing system. This system requires two components for the 
licensing process -- a valid and complete Product License and a valid Machine License. 
 
You will find the Product License in the body of the OtsTurntables license email, which is provided 
when you purchase an OtsTurntables license from http://OtsZone.com . 
 
The Machine License is obtained from the OtsZone.com servers, using either the automatic method (for 
internet-connected machines), or the manual method (for a non-internet-connected machines). The 
Machine License is issued specifically per machine. 
 
For instructions on obtaining a Machine License for a non-internet-connected machine please see the 
on-line OtsTurntables help documentation. 
  
For more information on the OtsReg licensing system please see, http://OtsZone.com/info/otsreg.html 
 
 
Licensing an internet-connected machine 
Note: To license OtsTurntables you must have either an OtsTurntables Bedroom, Silver or Pro 
Product License. To purchase an OtsTurntables license go to http://www.OtsTurntables.com/buy/ 

• Open OtsTurntables. 

• Click on the  button and click on License Info… option. 
• Click on the Enter/Edit button. This will take you to the Enter/Edit Product License 

window. 
• Copy and Paste your Product License into the Product License text area (Your Product 

License can be found in your OtsTurntables License email or can be retrieved from 
OtsZone.com). The Product License is 9 lines of text in total. You need to Copy and Paste all 
9 lines of text. See example below. 

  
Product License example: 
 
+++++ BEGIN OtsZone Product License +++++ 
Product=OtsTurntables 
Version=1.0 
Quantity=1 
Name=Michael Jackson 
Company= 
PDI=PAAA-ABCZ 
PL=L-2SHE-ECW4-P4HE-1HX3-7R25-JK3R-23XS-4QTH 
+++++ END OtsZone Product License +++++  

 
• Click on the OK button.   
• Now you will need to obtain a Machine License. Click on the Obtain button. 
• Click on the Automatically get machine license now button.  
• Click on the OK button.   
• Click on the Run Application button. 

  
 

Machine License example: 
The Machine License is a single line of text. 
 
M-14W3-K2ZP-R8L5-WPWT-WES2-FJHF-GMW3-6CDP 

 
 

http://OtsZone.com
http://OtsZone.com/info/otsreg.html
http://www.OtsTurntables.com/buy/
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OtsTurntables layout 
OtsTurntables has an intuitive easy to use screen layout. Common features and functions are accessible 
by clicking on the buttons provided on the main window, or through the Program Menu. 
 

Program Menu: The OtsTurntables Program Menu can be found by clicking on the  button in 
the top left-hand side of the window. 
 
Program Buttons: The buttons on the OtsTurntables window provide quick access to commonly used 
features and functionality. For a description of each button please see the OtsTurntables help file. 
 
Turntable Layout: OtsTurntables has two virtual turntables. These turntables provide powerful real-
time control and manipulation of your files.  
 
A Turntable has three states:  

• Idle state: No file loaded in the turntable. 
• Cue state: File is loaded into turntable and cued ready to play. Note, the file can be scratched 

in this state. 
• Playing state: The file is playing. 

 You are able to control both turntables using keyboard shortcuts, see below for details. 
 
 
Media formats 
OtsTurntables is able to play the following media formats: 

• MP3 files 
• Wave files 
• Ots Album files 
• Audio CDs 

 
Note: To play MP3 or Wave files in OtsTurntables they must have a Sample Rate of 44,100Hz, which 
is the present industry standard. The Bit Rate can be any bit rate including Variable Bit Rate. 
 
 
Preparing your media collection 
Before you load your media collection into OtsTurntables we recommend that you spend some time 
preparing your collection. 
 
 
How to prepare your MP3 files 
OtsTurntables uses the MP3 filename for labeling purposes. We recommend that you make sure your 
MP3 filenames follow the standard naming convention, which is Artist - Title.mp3. 
 
 
How to prepare your Wave files 
OtsTurntables will retrieve the Wave filename for labeling purposes. We recommend that you make 
sure your Wave filenames follow the standard naming convention, which is Artist - Title.wav. 
  
 
Converting your media to the Ots Album file format 
 
Note: When you purchase an OtsTurntables you will receive Ots Studio. Ots Studio can be downloaded 
from http://www.otslabs.com/studio/ as a stand-alone product.  
 
 

http://www.otslabs.com/studio/
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There are two conversion utilities for the purpose of converting your music files to the Ots Album file 
format: Ots Studio and the Ots MP3 Convertor. 
 
We recommend that our customers eventually migrate their files to the Ots Album file format for a 
number of advantageous reasons. For more details on the Ots Album file format see the OtsTurntables 
help file. 
 

Ots Studio icon 
 

 
  
You are able to simply and efficiently rip and encode your CDs directly into the Ots Album file format 
with the Ots Studio application. You can also convert your MP3 and Wave files to the Ots files with 
this tool. For instructions on configuring Ots Studio click here. For further information regarding Ots 
Studio please refer to the Ots Studio help file. 
 

Ots MP3 Convertor icon 
 

 
 
The Ots MP3 Convertor enables you to convert MP3 files directly into the Ots file format. For more 
details on the Ots MP3 Convertor see the Ots MP3 Convertor help file. 
 
 
OtsTurntables file processing explained 
When a file is loaded into a turntable, or added to the playlist, OtsTurntables checks it to see if it is 
playable. If it is a valid MP3 or Wave file, and if it is the first time that the file has been loaded, it will 
be processed to make it playable. If the file is an Ots Album file it will be checked for playability. 
While a file is being checked, or processed, the icon will remain gray. 
 
Note: The processing of MP3 or Wave files will take a few moments per file, due to data being 
retrieved, analyzed and stored. This process is a once-off process due to the fact that the calculated 
information will be stored in an associated .OMX file. 
 
When an unprocessed MP3 or Wave file is loaded into a turntable it will be placed at the top of the 
playlist and processing will begin on the file. If it is successfully processed it will be played. 
 
File processing in the playlist works in a top down manner -- files at the top of the playlist are checked 
and processed first. When the order of a playlist changes processing requirements also change, e.g. a 
file placed at the top of the playlist will be considered urgent and given processing preference over a 
file further down in the list. 
 
Once a file is successfully checked, and/or processed, the file's icon will be colored and the file will be 
immediately playable in OtsTurntables. 
 
If the file is non-playable the file's icon will be crossed. For a report of why a file is non-playable, 
double-click on the file and read the information in the Status field. When a non-playable file is loaded 
into a turntable it will be skipped. If the file was part of a playlist the next playable item will be played. 
 
Items in a playlist file (.ofl) will be marked non-playable if you have moved the file on your hard drive 
from it's original location. In this case relocate the files to the original location or recreate the playlist 
file. To revalidate a playlist go to Actions -> Revalidate All Items on the playlist control panel. To 
remove all non-playable items go to Actions -> Remove Non-Playable Items on the playlist control 
panel. 
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File icons status 
 

MP3 Wave Ots Album Status summary 

   A gray icon means that the file is unchecked, or in the 
midst of being checked or processed. In this state the file 
is not playable. 

   A colored icon means that a file is playable. It has been 
checked and/or processed. 

   A crossed icon means that the file is non-playable. This 
may be due to the file being unavailable or corrupt. 

  
Note: To play MP3 or Wave files in OtsTurntables they must have a Sample Rate of 44,100Hz, which 
is the current industry standard, and includes all music contained on audio CDs. The Bit Rate can be 
any bit rate including Variable Bit Rate. 
 
 
Moving MP3 or Wave files on your hard drive 
When moving Wave or MP3 files, which have been played in OtsTurntables, you will need to also 
move the associated Ots Media Extension file (.OMX file). If you do not move the OMX file with the 
Wave or MP3 file, the file will need to be re-processed, should you wish to play it again in 
OtsTurntables. The OMX file can be found in the same location as the file it is associated with. 
 
Example of an MP3 file and associated OMX file: 
Madison Avenue - Don't Call Me Baby.mp3 
Madison Avenue - Don't Call Me Baby.mp3.omx 
 
 
Using OtsTurntables 
In this section you will find operating instructions for OtsTurntables. For a more detailed explanation 
of the features and functions of OtsTurntables please see the on-line OtsTurntables help documentation. 
 
 
How to play your music 
OtsTurntables enables you to mix and scratch your MP3, Wave, Ots Album, and CD Audio files like 
a Pro DJ. 
 
Note: To play MP3 or Wave files in OtsTurntables they must have a Sample Rate of 44,100Hz, which 
is the current industry standard. The Bit Rate can be any bit rate including Variable Bit Rate. 
 
To play your music files in OtsTurntables you can either: 

• Load a file directly into one of the turntables. 
• Create a playlist of songs -- which OtsTurntables will play sequentially -- by adding files or 

folders of files to the playlist area. 
• Right-click on a file, or group of files, and select the Play with OtsTurntables option to 

have OtsTurntables play the file. 
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How to play a file in OtsTurntables 

• Click on the  button under the turntable that you want to load the file into. 
• Click on Load file... option. 
• Navigate to the file you want to load. 
• Select the file. 
• Click on the Open button. 

 
If the file selected is an MP3 or Wave file, and it has not been played in OtsTurntables before, 
it will be checked, placed at the top of the playlist and processed. For an explanation of what 
is occurring during processing see the OtsTurntables file processing explained section 
above. Once processed, the file will be placed in the turntable. 

 
Note: The processing of MP3 or Wave files will take a few moments per file, due to data 
being retrieved, analyzed and stored. This process is a once-off process due to the fact that the 
calculated information will be stored in an associated .OMX file. 

 
If the file selected is an Ots Album file that contains multiple items (tracks), you will 
prompted by a dialog box allowing you to select the item that you would like to load into the 
turntable. Select the item and click on the OK button. The item will be checked and placed in 
the turntable. 
 

• To play the file, click on the  button. 
 
 
How to play a CD track in OtsTurntables 

• Open OtsTurntables. 
• Insert an audio CD into your CD-ROM. 

• Click on the  button in the playlist control area. You will be prompted by the The 
CD-DA subsystem is not currently enabled dialog box. Click on the Yes button to enable 
the CD-DA subsystem. Alternatively, go to Options -> CD-DA Subsystem and select the CD-
DA Subsystem Enabled option. 

• If it is the first time this CD has been played in OtsTurntables it will need to be processed. 
Processing will take a few moments. The information retrieved will be stored in the 
OtsTurntables CD cache system for fast future processing. 

• Click on the  button in the playlist control area. 
• Select the track or tracks you wish to add to the playlist. 

• To play, click the  button. 
 
Note: With a good quality CD-ROM you are able to play two tracks, from the same CD, at the same 
time. For more information please read the Ots Labs CD-DA subsystem requirements in the 
OtsTurntables help file.  
 
If you have two CD-ROM drives you can play tracks from two CD-ROMs at the same time. 
 
 
How to eject a file from a turntable 

• Click on the  button under the turntable. 
• Select the Eject... option. The file will be ejected from the turntable. 
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Creating a playlist  
 
Question: What is a playlist? 
 
Answer: A playlist is a list of items (files) which are played sequentially (in order) from top to bottom. 
 
OtsTurntables enables you to very simply create a playlist containing your MP3, Wave, Ots Album, or 
CD Audio files. Once created, you can either sit back and enjoy as OtsTurntables takes care of the mix, 
or if you are a little more adventurous -- a DJ by nature -- you can interactively mix between the items 
in the playlist yourself. 
 
With OtsTurntables there is no practical limit to the length of a playlist (number of items in the 
playlist). You can create a list consisting of your entire collection if you so wish. 
 
Editing a playlist is very simple. Files, or folders of files, can be added to the playlist using the playlist 
control buttons. For details on the playlist control buttons see the OtsTurntables help file. If you wish to 
move files up or down in the playlist simply drag and drop the files. To delete files from the list simply 
press the Delete button or right-click and select the Delete from List option. 
 
The End of List marker shows the end of the current playlist. Items that have been placed in a turntable 
are automatically added to the bottom of the list, after the End of List marker, which in effect creates a 
history list. When a playlist is exhausted, when the End of List marker has been reached, by default 
OtsTurntables will continue to play the items after the End of List marker therefore providing you with 
continuous play. 
 
When files are added to the end of the playlist (using the Add and End options) they are added before 
the End of List marker. 
 
You are able to save a playlist so it can be used again at a later date. This feature is great for creating a 
tailored playlist for a specific purpose, e.g. a birthday party. Once you are at the party you can start 
with the saved playlist and simply add to, or remove items, to suit your party requirements. 
  
To view the playlist area click on the  button. The playlist area will drop down below the 
turntables. 
  
Tip: You are able to command OtsTurntables to open the playlist area at program startup. In the main 
menu go to Options and select the Playlist Displayed at Program Startup option. Alternatively, 
select the Full Screen Mode at Program Startup option. 
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How to add a file to the playlist 
• To display the playlist area click on the  button. 
• Before you load the file(s) you will need to consider how you would like the file(s) loaded. 

You will need to set the Mode and Add options on the playlist control panel. 

 If you would like the file(s) to replace the current list click on the  button. 

Alternatively, if you would like to add the file(s) to the current list click on the  

button and select one of the Add options;  will add the file(s) to the top of the list; 

 will add the file(s) to the end of the list (not to be confused with the bottom of the 
list).  

• Click on the  button on the playlist control panel. 
• Navigate to the file(s) you wish to add to the playlist. To learn about compatible file formats 

see above. 
• Select the file(s). Note, if you wish to select multiple files use Ctrl + left-click or Shift + left-

click. 
• Click on the Open button. 
• The file(s) will be added to the playlist and checked for playability. The file's icon will be 

gray until checked and/or processed. For an explanation of the various file icon states see the 
OtsTurntables file processing explained section above. 
 
If the file(s) selected is an MP3 or Wave file, and it has not been played in OtsTurntables 
before, it will be checked and processed. For an explanation of what is occurring during 
processing see the OtsTurntables file processing explained section above. 

 
Note: The processing of MP3 or Wave files will take a few moments per file, due to data 
being retrieved, analyzed and stored. This process is a once-off process due to the fact that the 
calculated information will be stored in an associated .OMX file. 
 
If the file you selected is an Ots Album file that contains multiple items (tracks), you will 
prompted by a dialog box allowing you to select the items that you would like to load into the 
playlist. Select the item and click on the OK button. 

 

• To start playing the playlist click on the  button. 
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How to add a folder of files to the playlist 

• To display the playlist area click on the  button. 
• Before you load your folder you will need to consider how you would like the folder loaded. 

You will need to set the Mode and Add options on the playlist control panel. 

 If you would like the folder to replace the current list click on the  button. 

Alternatively, if you would like to add the folder to the current list click on the  

button and select one of the Add options;  will add the folder to the top of the list; 

 will add the folder to the end of the list (not to be confused with the bottom of the 
list). For more details on the playlist control buttons see the OtsTurntables help file. 

• Click on the  button on the playlist control panel. 
• Navigate to the folder of files you wish to add to the playlist. To learn about compatible file 

formats see above. 
• Select the folder you want to place in the playlist. 
• Click on the Open button. 
• The files from the folder will be added to the playlist and checked for playability. Each file's 

icon will be gray until checked and or processed. For an explanation of the various file icon 
states see the OtsTurntables file processing explained section above. 
 
If the files are MP3 or Wave files, and if they have not been played in OtsTurntables before, 
they will be checked and processed. . For an explanation of what is occurring during 
processing see the OtsTurntables file processing explained  section above. 
 
Note: The processing of MP3 or Wave files will take a few moments per file, due to data 
being retrieved, analyzed and stored. This process is a once-off process due to the fact that the 
calculated information will be stored in an associated .OMX file. 

 

• To start playing the playlist click on the  button. 
  
Tip: With a command-line argument you are able to command OtsTurntables to automatically load a 
folder and randomize it. For instructions see the OtsTurntables help file.  
 
 
How to remove items from the playlist 

• Select the item(s) that you would like to remove from the playlist. 
• Press the Delete key. You will be prompted by the Delete selected Items from playlist dialog 

box. Click on the Yes button. Alternatively, right-click and select the Delete From List 
option. 

• The item(s) will be removed from the playlist. 
 
Tip: To remove multiple items select the multiple items using Ctrl + left-click or Shift + left-click. 
 

Note: If you wish to clear the entire playlist click on the  button on the playlist control panel. 
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How to randomize a playlist 

• Open or create the playlist that you would like randomized. 

• Click on the  button. 
• Select the Shuffle option. Your playlist is now randomized. 

 
 
How to search for a song in the playlist 

• Click on the  button and select the Find... option. Alternatively, right-click and 
select the Find in List... option, or press Ctrl + F. 

• Select the required search options in the Options area. 
• Type into the Search Text input box the search criteria. 
• Click on Find Next button until you locate the song. 
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Saving and loading a playlist 
With OtsTurntables you are able to save a playlist as a playlist file so that you can, at a later date, load 
the playlist file to have OtsTurntables play the list. 
This feature is great for users who want to create a predefined playlist for a specific purpose, e.g. for a 
specific party or gig, or for their own listening pleasure. 
 
Notes: When using a playlist file (.OFL file) you will need to bear in mind that the files referenced in 
the playlist file, must be in the same location on your hard drive that they were in at the time of the 
creation of the file. If your playlist file is not working it is most probably because you have moved your 
files on your hard drive. 
OtsTurntables is able to load Winamp .m3u playlist files. 
 
 
Saving a playlist 

• Click on the  button on the playlist control panel. 
• Navigate to where you would like to save the playlist file. The default location is 

C:\OtsLabs\Templates 
• Name the file. For this example name it test. 
• Click on the Save button. 

 
 
Loading a playlist 

• Before you load your playlist file you will need to consider how you would like it loaded. You 
will need to set the Mode and Add options on the playlist control panel. 

 If you would like the playlist to replace the current playlist click on the  button. 
Alternatively, if you would like to add the playlist to the current playlist click on the 

 button and select one of the Add options;  will add the playlist to the top 

of the playlist;  will add the playlist to the end of the playlist. For more details on 
the playlist control buttons see the OtsTurntables help file.  

• Click on the List button on the playlist control panel. 
• Navigate to the playlist file you would like to load. In this example find the test.ofl file you 

created.  
• Select the playlist file and click on the Open button. 
• The playlist will be added to the playlist area. 
• The files in the playlist will be checked and/or processed. During this time each file's icon will 

remain gray. For an explanation of the various file icon states see the OtsTurntables file 
processing explained section above. For an explanation of MP3 and Wave file processing see 
the OtsTurntables file processing explained section above. 

 
If you would like the playlist randomized see the How to randomize a playlist instructions above. 
 
Tip: With a command-line argument you are able to command OtsTurntables to automatically load and 
randomize a playlist file. For instructions see the OtsTurntables help file.  
 
Note: Items in a playlist file (.ofl) will be marked non-playable if you have moved the file on your hard 
drive from it's original location. In this case relocate the files to the original location or recreate the 
playlist file. To revalidate a playlist go to Actions -> Revalidate All Items on the playlist control panel. 
To remove all non-playable items go to Actions -> Remove Non-Playable Items on the playlist control 
panel. 
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Turntable effects 
OtsTurntables has a number of turntable effects that can be applied to a file to give it that realistic vinyl 
sound. These effects include record surface noise, turntable platter flutter, turntable braking, and the 
ability to scratch a file like you would a record. 
 

To access the Turntable effects menu click on the turntable's  button. 
 
Surface Noise: The Surface Noise effect contains three components of surface noise that you would 
expect to hear on a standard turntable - motor rumble, pops (static noise), and crackles. 
 
Brake Effect on Stop: The Brake Effect on Stop effect emulates the sound that you would hear when 
you applied the brake to the turntable when playing a record. 
 
Platter Flutter: The Platter Flutter effect emulates the flutter noise that all turntables exhibit, being 
mechanical devices. There are three Platter Flutter options: 

• Direct-Drive (Pro): Emulates the amount of platter flutter present on a typical pro-grade 
turntable. Most people will not be able to consciously discern the difference between this setting 
and the "None" setting, however it is there, and adds to the whole vinyl experience. 

• Belt-Drive: Emulates the platter flutter that you would expect to hear from a belt-drive turntable. 
• Belt-Drive (Cheap!): Emulates the platter flutter that you would expect to hear from a poor 

quality, cheap, belt-drive turntable. 
 
Progress Bar Scratching:  The Progress Bar Scratching effect emulates what you would expect to 
hear if you dragged a turntable needle across a record. To hear the Progress Bar Scratching effect, 
simply click on the progress bar ahead of or behind the current playing position (try holding the 
mouse button down while dragging too). 
 
Stuck-Needle effect: The Stuck-Needle effect emulates what you would hear when a turntable needle 
can't get past a scratch or defect on a record causing one groove of the record to be continuously 
repeated each revolution. 
 
Below are the default turntable effects settings: 

• Brake Effect on Stop: Enabled. 
• Surface Noise: Disabled. 
• Platter Flutter: Direct-Drive (Pro) Enabled. 
• Progress Bar Scratching: Enabled. 
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Scratching effects 
OtsTurntables has the amazing ability to allow you to scratch a file just like you would a vinyl record. 
OtsTurntables has an incredibly low latency mechanism which provides realistic instant responses to 
scratch movements. 
 
There are two turntable states that you can scratch a file in: 

• Cue state: Scratch movements can be applied to a loaded record in this stationary state. 
• Playing state: Scratch movements can be applied while the record is playing. 

 
 
How to scratch a file 

• Select a file that you want to scratch on a turntable. 
• Hover over the virtual record with the mouse.  
• Click on the virtual record and move forwards and backwards (in a circular motion), at any 

speed, to hear exactly what you would hear if you applied those same movements to real 
vinyl.  

• Use the left mouse button for normal scratching.  
• Use the right mouse button for catch-up scratching. See below for details. 

 
Tip: The closer you click to the center of the record, the greater the amount of momentum applied. 
 
 
How to scratch and keep in time 
Scratching with your right mouse button enables you to scratch and keep in time. Right-click scratching 
utilizes catch-up functionality, which means that once the scratching has completed the virtual record 
will catch up to the would-be playing position, had you not performed the scratch, therefore keeping 
you in perfect time with the music. 

• Select a file that you want to scratch on a turntable. 
• Hover over the virtual record with the mouse.  
• Right-click on the virtual record, scratch back and forth at any speed, and when you release 

the mouse button OtsTurntables will catch up to the would-be playing position. 
 
 
How to apply muting to a scratch 
When scratching a record you can mute the sound in either direction by holding down the Ctrl or Shift 
keys. 

• Ctrl will mute back spins. 
• Shift will mute forward spins. 

When you let go of the record the Ctrl muting will stop even if you have the button held down. 
However Shift will continue the muting until you let go of the button. (If you are playing a song in the 
backwards direction mode the opposite is true). 
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Scratch samples 
Scratch samples are recorded scratch movements that can be applied to any file. OtsTurntables has five 
preset scratch samples for each turntable. The first two scratch samples are generic and are not tempo 
dependant. The remaining three are best suited for music with a tempo of around the 120 beats per 
minute mark. The five preset scratch samples are best applied on the fourth beat of the bar. 
 

Scratch sample keys 
 

Turntable Keys 

Turntable A 1-5 keys 

Turntable B 6-0 keys 
 
 
How to apply a scratch sample to a file 

• Load a file into Turntable A. 
• Press a key between 1 and 5 to hear the scratch sample applied to Turntable A. 
• When applying a scratch sample to Turntable B press a key between 6 and 0. 

 
 
Scratch Sampler 
The Scratch Sampler enables you to sample your actual scratch movements, up to four seconds per 
scratch sample, and save them for later use. The scratching movement is sampled, not the audio 
component, so this allows you to apply the scratch-style to all types of music and at any part of a song. 
There are five scratch sample positions available. 

To find the Scratch Sampler dialog box click the  icon on the toolbar. 
 
 
How to record a scratch sample 
You can record as many scratch samples as you like and when required load them into the five scratch 
sample positions, Scratch #1 - Scratch #2. 
 
As an example we will save a scratch sample in the Scratch #1 position (available for keys 1 or 6).  

• Load a file into Turntable A. 
• Press the Shift + 1 keys. Notice the Turntable A's LED is flashing orange. You are now in 

recording mode. You have up to four seconds of recording time.  
• Scratch the file. After four seconds the LED will stop flashing. This indicates the recording 

has stopped. 
• You can now test the scratch by pressing the number 1 or number 6 keys when a file is 

playing. 

• Once you are happy with your scratch sample, click the  icon to open the Scratch 
Sampler dialog box. 

• Type your Title and Artist information. 
• Click the Save button and give the scratch sample a filename. In this example type "first". 
• Click the Save button. 

 
Tip: If you place a turntable in the 0% Direction position you can scratch from a stationary position. 
In this mode you can begin scratch sample recording. 
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Ots Labs Dynamics Processor 
A dynamics processor allows you to control the level (volume) of your audio. When set up correctly, it 
does this in a transparent way, not making hugely noticeable alterations to the sound, but nevertheless 
giving you the control that you may need. Radio stations, television stations, pro club DJs, etc, use 
dynamics processors. 
 
With OtsTurntables you receive a fully fledged, pro-quality dynamics processor comprising AGC, 
compressor and limiter. Full control is given to each of the characteristics of each processor section. 
You can duplicate a squashy or punchy radio sound if you like, but you can also obtain smooth, 
consistent audio that is not noticeably altered from the original. Whatever your requirements are at 
anytime, you can quickly adjust the settings and your levels will be handled professionally. 
  

To find the Dynamics Processor dialog box click on the  button, or right-click on the Dynamics 
Processor meter. 
 
 
Ots Labs Graphic Equalizer 
The Ots Labs graphic equalizer is a unique zero latency, one octave stereo graphic equalizer. It is 
useful for general tonal corrections, to obtain the most desirable sound quality. It can also be used to 
reduce the effect of resonant peaks and dips in loudspeaker response, and in the acoustic environment, 
reducing the tendency for acoustic feedback. 
 

To find the Graphics Equalizer dialog box click on the  button. 
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Mixing 
OtsTurntables utilizes the unique Ots ACI mixing subsystem (Auto DJ). This subsystem will 
automatically mix your files providing intelligent and seamless mixes every time. 
 
If you wish you can totally manually mix with the OtsTurntables instant response Software Mixer. To 
learn more about the Software Mixer see below. 
 
 
Ots Labs Auto DJ mixing 
The Auto DJ feature has extremely accurate automatic mixing point technology. You will hear 
intelligent automated mixing that you would expect to hear from a professional DJ.  
 
The Auto DJ feature analyzes the way that a song starts and ends and works out an appropriate mix. It 
does not simply overlap the songs by a set number of seconds like many programs do as they crudely 
attempt to mix. With the Auto DJ feature you get perfect mixes every time. 
  
 
OtsTurntables Mixer 
OtsTurntables has an in-built instant response Software Mixer console. You can use the Mixer console 
just like you would use a standard hardware mixer. 
 
OtsTurntables Mixer console: 

• Cross-fader slider: This control is used to fade between turntables. 
• Turntable A level slider (left vertical slider): This slider is the Turntable A volume level 

control.  
• Turntable B level slider (right vertical slider): This slider is the Turntable B volume level 

control. 
 
Note: It is normally not necessary to use the Turntable A and B level controls at all, since the Ots Labs 
Dynamics Processor elegantly handles the audio level control. 
 
The Mixer console has a range of automated cross-fader sweeps that can be fired off using the numeric 
keypad. See below for Keyboard shortcuts. 
 
 
Pitch/Tempo Bending feature 
You are able to apply Pitch or Tempo bends to playing files. This feature is great for synchronizing 
files when manual beat mixing.  
 
To select either the Pitch or Tempo Bending options go to Main Menu -> Options -> Pitch/Tempo 
Bending and select either the Pitch or Tempo option. 
 
See the Keyboard shortcut table below for Pitch/Tempo Bending keys. 
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Configuring your soundcard 
OtsTurntables will automatically detect available soundcards and provide you with a selection of your 
soundcard drivers. If you need to manually configure your systems soundcard read on. 
 
Windows 2000/XP/Vista users should select the WDM type drivers, unless you have soundcard 
problems, in which case you would be best to select the Compat type drivers. 
 
 
How to configure your soundcard 

• Click the on the Ots Labs Power Amplifier in the OtsTurntables window. This will open 
the Output Configuration dialog box.  

• Click the Set button, for the "ON-AIR" output device.  
• In the Select "ON AIR" Output Device dialog box you will notice a listing of your 

soundcard drivers. 
• Select the drivers that suit your operating system. 
• Click on the OK button. 
• Close the Output Configuration dialog box. 
• To test, play a file. 

 
Tip: If you notice any warbles and/or pops when using the WDM type drivers you may need to 
calibrate the Audio Output Device. See below 
 
Note: For all other audio output related problems please see The Audio FAQ section below. 
 
 
How to calibrate the soundcard output device 
If you ever experience warbles and/or pops when OtsTurntables is playing you may need to re-calibrate 
the soundcard. 
 
Note: The audio output device calibration settings only applies to true WDM drivers.  
 

• Click the on the Ots Labs Power Amplifier in the OtsTurntables window. This will open 
the Output Configuration dialog box. 

• Click the Cal button for the "ON AIR" output device. 
• In the Optimize Buffering section you will need to adjust the Optimize buffering slider to 

suit your system. 
• The idea is to lower latency, but without getting any cracks and pops. Position the slider after 

(to the right of) the region that causes the cracks and pops. Since this function is circular in 
how it works internally, the optimum position may actually be near the left of the slider (if the 
region of cracks and pops is to the far right). 

• Be sure to test your chosen setting under heavy system load, as some positions may seem fine 
until your system is loaded. Leaving a space of about 20 percentage points between the end of 
the region of cracks and pops and the position of the slider is usually optimum. 

• If your soundcard appears in the Output device list as a Legacy type, then you will normally 
be better off using it via the Legacy means, rather than the WDM. 
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Audio output FAQ – Troubleshooting 
Question: OtsTurntables reports "Error initialising audio sub-system!". What does this mean? 
Answer: You must have Direct X 5.0 or above installed on your system, and be running Direct Sound 
(VXD) or WDM drivers for your sound card. If your computer does not have both of these 
requirements, you should download the latest drivers for your soundcard, and or go to 
http://www.microsoft.com to download the latest Direct X version. If you are not sure if your computer 
meets these requirements, seek some advice from your computer supplier. 
  
 
Question: The audio output sound warbles and/or pops. What can I do? 
Answer: First thing to try is calibrating your sound if you are using the WDM driver type (does not 
apply to legacy mode). See section above on How to calibrate the audio output device. 
 
 
Question: I still can not get it to sound right, no matter where I put the calibration slider. What next? 
Answer: You may have the choice of using the "legacy", "WDM", or "Compat" driver types. Try 
changing to the other available driver types. See section above on How to configure your audio output 
device. 
  
 
Question: I have tried calibrating the WDM driver type, and accessing the other driver types, and 
neither have given me stable sound. What now? 
Answer: Some hardware is designed poorly and will not function well with OtsTurntables. Sometimes 
this is simply due to the drivers installed, and by downloading the latest drivers for your soundcard, 
you can often alleviate any problems. To do this, go to your soundcard manufacturer's website, 
download and install the up-to-date drivers. This may take some trial-and-error to find out the best 
drivers for your system. If you do not feel comfortable with this, seek the assistance of your computer 
supplier. 
 
Note: Some on-board soundcards are low quality products and have badly written drivers. You may 
find you have no success even after installing the latest drivers. If this is the case, then you may want to 
look at a PCI or USB soundcard. It is highly recommended that this avenue is explored through a 
computer dealer so that testing with the OtsTurntables can be attempted before making a financial 
commitment. 
 
 
Question: I'm experiencing skipping when I run OtsTurntables. How do I avoid this? 
Answer: There are many potential causes. Here are a few: 

• Virus checkers running constantly in background. You could try turning them off. 
• Poorly written printer/scanner drivers. Update them or change configuration settings. 
• Running other memory intensive applications at the same time as OtsTurntables. Don't run 

these type of applications at the same time. 
• Being infected by a virus. Use a virus scanner to check your whole system. 
• Windows 2000: Having the "menu effects" turned on will cause glitches. Switch them off 

under Display Properties in Control Panel. 
 
Question: I'm experiencing skipping when I open or close a window (Windows 2000). How do I stop 
this? 
Answer: If you are using Windows 2000 you will need to disable the Use Transition effects for menus 
and tooltips feature. This feature may cause skipping when you open or close a window. 
 
How to disable Use transition effects for menus and tooltips (Windows 2000 only): 

• Right-click on the Desktop. 
• Click on Properties. 
• Click on the Effects tab. 
• Uncheck/Disable the Use transition effects for menus and tooltips option. 

http://www.microsoft.com
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Hercules DJ Controller MK1 Mappings with OtsTurntables 
Below is a table outlining the Hercules DJ Controller MK1 Mappings with OtsTurntables. 
 
Note: The left and right mouse buttons on the controller are used as "shift" keys. In most cases, using 
either the left or right button will have the same effect, however some functions work differently 
depending on whether you use the left or right shift key (mouse button). In the following, if the word 
'shift' is used, it means you can use either key, whereas 'left shift' and 'right shift' obviously refers to a 
specific key. 
 
Control Function 

Play/Pause Play or pause the current loaded item. 

Cue If in play mode and pressed will return to cue point. In pause mode press to frame seek (frame 
search). When in frame seek mode press again to set cue point.   

Next Track Grabs the next from the playlist and loads it into turntable. 

Shift + Next Track Fades the current item and automatically begins playing the next. 

Previous Track Ejects turntable. 

Crossfader  Fades between turntables. 

Left Shift + Crossfader Centres the crossfader. 

Right Shift + Crossfader Shifts crossfader to hard left or hard right, depending on which direction you moved the 
crossfader. 

Pitch Bend Bends pitch or tempo by a small percentage. 

Autobeat Enables/disables "on-air" channel for that turntable. 

Monitor  As expected, enables/disables "cue" channel for that turntable. 

FX/Cue/Loop Toggles between "pitch, "tempo" & "direction" modes. 

Pitch Slider Adjusts the pitch, tempo or direction, based on current mode. 

Left/Right Shift + Pitch Slider
  

Sets pitch, tempo or direction to the centre position, or to 100% forwards or backwards (if in 
direction mode and using the right shift button).   

Jog  Skips +/- one frame at a time when in frame-seek cueing mode. 

Shift + Jog Skips +/- ten frames at a time when in frame-seek cueing mode.  

Master Tempo (left) Toggles AutoDJ mode. 

Master Tempo (right) Disabled. 

Volume Adjusts the mixer volume for turntable. 

Bass Adjusts bass for turntable. 

Mid Adjusts mid range for turntable. 

Treble Adjusts treble for turntable. 

Effect 1 Applies the number one scratch sample. 

Effect 2 (left) Applies the number two scratch sample. 

Effect 3  Applies the number three scratch sample. 

Shift + Effect 1/2/3 Enables record mode for the scratch sampler. 
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Keyboard shortcuts 
Below is a comprehensive list of the keyboard shortcuts available in OtsTurntables. 
 

Menu keys 
 

Key Action 
Alt + F Provides access to the program menu. 
Alt + Z Provides access to Turntable A menu. 
Alt + X Provides access to Turntable B menu. 

 
 

Full Screen Mode keys 
 

Key Action 
Esc Full Screen Mode. 

 
 

Global Transport keys 
 

Key Action 
Ctrl + P Global Play. 
Ctrl + Q Toggles Pause on and off. 
Ctrl + S Global Stop. 
Ctrl + B Previous Item. 
Ctrl + N Next Item. 

 
Auto DJ keys 

 
Key Action 

Ctrl + A Toggles Auto DJ on or off. 
 
 

Turntable A keys 
 

Key 
combinations 

F1 F2 F3 F4 

 Stop/Jump To Cue 
Point 

Play Bend Down 
(Tempo/Pitch) 

Bend Up 
(Tempo/Pitch) 

Shift Fade Stuck Needle mode Direction 100% 
Reverse 

Direction 100% 
Forward 

Ctrl Seek Start Set Cue Point Seek Back 
(1 frame) 

Seek Forward 
(1 frame) 

Ctrl + Shift Eject Next Seek Back 
(10 frames) 

Seek Forward 
(10 frame) 

Alt Pitch Down 
(0.5%) 

Pitch Up 
(0.5%) 

Tempo Down 
(0.5%) 

Tempo Up 
(0.5%) 

Alt + Shift Pitch Down 
(0.1%) 

Pitch Up 
(0.1%) 
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Turntable B keys 
 

Key 
combinations 

F5 F6 F7 F8 

  Stop/Jump To Cue 
Point 

Play Bend Down 
(Tempo/Pitch) 

Bend Up 
(Tempo/Pitch) 

Shift Fade Stuck Needle mode Direction 100% 
Reverse 

Direction 100% 
Forward 

Ctrl Seek Start Set Cue Point Seek Back  
(1 frame) 

Seek Forward  
(1 frame) 

Ctrl + Shift Eject Next Seek Back  
(10 frames) 

Seek Forward  
(10 frame) 

Alt Pitch Down 
(0.5%) 

Pitch Up 
(0.5%) 

Tempo Down 
(0.5%) 

Tempo Up 
(0.5%) 

Alt + Shift Pitch Down 
(0.1%) 

Pitch Up 
(0.1%) 

  

 
 

Playlist keys 
 

Key Action 
Ctrl + W Show/Hide Playlist window. 
Ctrl + O Opens the Open Ots/Wave/MP3 Files dialog box.  

Ctrl + F Opens the Find Item in Playlist dialog box. 

 
 

Pitch/Tempo bending keys 
 

 Turntable A 
Key Action 
F3 Bend Down (Tempo/Pitch) 
F4 Bend Up (Tempo/Pitch) 

Turntable B 
Key Action 
F7 Bend Down (Tempo/Pitch) 
F8 Bend Up (Tempo/Pitch) 

 
 

Scratch Sample keys 
 

 Turntable A 
Key Action 

1 Applies the number 1 scratch sample to Turntable A 
2 Applies the number 2 scratch sample to Turntable A 
3 Applies the number 3 scratch sample to Turntable A 
4 Applies the number 4 scratch sample to Turntable A 
5 Applies the number 5 scratch sample to Turntable A 

  
Turntable B 

6 Applies the number 1 scratch sample to Turntable B 
7 Applies the number 2 scratch sample to Turntable B 
8 Applies the number 3 scratch sample to Turntable B 
9 Applies the number 4 scratch sample to Turntable B 
0 Applies the number 5 scratch sample to Turntable B 
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Record scratch sample keys 
 

Turntable A 
Key Action 

Shift + 1 Number 1 scratch sample record mode. 
Shift + 2 Number 2 scratch sample record mode. 
Shift + 3 Number 3 scratch sample record mode. 
Shift + 4 Number 4 scratch sample record mode. 
Shift + 5 Number 5 scratch sample record mode. 

  
Turntable B 

Shift + 6 Number 1 scratch sample record mode. 
Shift + 7 Number 2 scratch sample record mode. 
Shift + 8 Number 3 scratch sample record mode. 
Shift + 9 Number 4 scratch sample record mode. 
Shift + 0 Number 5 scratch sample record mode. 

 
 

Air/Cue keys 
 

Key Action 
Ctrl + 1 Turntable A On-Air. 
Ctrl + 2 Turntable A Cue. 
Ctrl + 6 Turntable B On-Air. 
Ctrl + 7 Turntable B Cue. 

 
 

X-Fader Numeric keys 
 

Key Action 
7 Instantly fade to Turntable A 
8 Instantly fade to centre position 
9 Instantly fade to Turntable B 
 
4 Quickly fade to Turntable A 
5 Quickly fade to centre position 
6 Quickly fade to Turntable B 
 
1 Slowly fade to Turntable A 
2 Slowly fade to centre position 
3 Slowly fade to Turntable B 
 
0 Steps fader in the left direction 
Del Steps fader in the right direction 

 
Note: The Num Lock keyboard option must be enabled for the X-Fader feature.  
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